RTK logger FI9C setting manual
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1. About FOC

€ F9C is RTK data logger powered by ublox ZED-F9P.

€ Contact "Sensorcomm” to purchase.
http://www.sensorcomm.co.jp/

€ ESP32 WiFi and Bluetooth module is included.
(Case 2 and Case 3 are alternative)

Casel Case2 Ntri Case3
Antenna Antenna Antenna
Bluetooth
I T P -
ESP32 ESP32 ESP32
A A
USB A 4 A 4
ZED-F9P N Mzr:tc;ry | Power ZED-F9P | Power ZED-FOP
Single Positioning bank RTK bank RTK
S 2/ - [ RTK Result |—— - | RTK Result |
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http://www.sensorcomm.co.jp/

1. About F9C

€ Power consumption

Tested with 10000mAh power bank.
(Bluetooth and WiFi power consumption depend on the signal environment)

20 h > 16 h

Running time 24 h >
Casel Case2 . Nirip Cased Nirip
|=|
B B Bluetooth B wif
@ RTK Result / -
F9c Fac e F9c / ==
ESP32 ESP32 ESP32 RTK Result
USB ! USB ! USB
ZED-F9P Memory Power zep-Fop || Memory Power ZED-Fop | | Memory Power
Single Positioning data bank RTK data bank RTK data bank
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2. F9P setting

FOC can’t log data in factory default. You have to set it up yourself.

1. Install u-center, ublox GNSS software in your PC.
https.//www.u-blox.com/en/product/u-center

File Edit View Player Receiver Tools Window Help
ODd=~ & ARB BP0 EE~-RBA-E-m~
qe w M ow | = * - i—————————————

Ready
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https://www.u-blox.com/en/product/u-center

2. F9P setting

2. Connect GNSS Antenna.
3. Connect your PC and F9C by USB cable.

USB
Memory

-

F9C

USB ESP32
UART2 TX UART2 RX

A

\ 4

UART1T RX UART1T TX

ZED-F9P
USB
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2. F9P setting

4. Select COM port and connect to FOP.

A TR TH-Tv- - o
IrE BEE FTW ALVH
e @ EHE B EXE

= VATL TR
B w¥3UF 7R
B UIRIIT FRAX
= F1A9 F517
R F1AT A FETH-
& RybI-7 7975~
B by 1YF-TIMA TIMR
¥ 77-L717
= JU»s-
0O Jowvy
B #-FTN FrRAR
~ i@ fi-kcom & P
@ comOcom - serial port emulator (COM20)
21)
@ usB YT 7R (com13)
o

G u-center 20,01

File Edit WView Player Receiver

Tools Window Help
E Y e=e]

J_

DE =~ -
d0 w U w \ Hiﬁ . -
[ . Disconnect Cirl-0
CORA] ~irl 1
COoOM13 Ctrl-13 I
COM20 Ctrl-20
com21 Ctrl-21
Network connection N
Location API
Sensor AP
Universal Gnss Dirivi 10)

© cOM13 - u-center 20.01
File Edit View Player Receiver Tools Window Help
O &~ & aha B0 E-vA-vE-vm- OB B0 EE&E S

o v | A [ - I

Ready €¢ NTRIP client: Not connected

u-blox Generation ¢|=@= COM13 9600 |No file open UBX  |00:02:5:01:03:1 | &

6



2. F9P setting

Download newest Firmware from u-blox web site.
https.//www.u-blox.com/en/product/zed-f9p-module#tab-documentation-resources

Tools>Firmware Update

Select image file you downloaded and click “GO”,

@ coM13 - u-center 20.01

File Edit View Player Receiver Tools Window Help

DE =~ Firmware Update...

o v v | o .
— Dump Receiver Diagnostics...

u-blox 7,/8/M8 Retrieve Log...
AssisthNow Offline

AssistNow Online

Receiver Configuration...

Hotkeys...

Preferences...

g Firmware Update Utility

E=8E0R 5

Firmware image
‘b\ox7F9P¥ReceiverConﬁg¥UEX7F971007HPG?11272ED7F9P.aZE-bfd!j

[~ Use this baudrate for update [¥ Enter safeboot before update

9600 [~ Send training sequence

[~ Use chip erase
[~ Transfer image to RAM

Additional options

Command line

1 "E¥Document¥GNSSUblox¥Ublox_FOP¥ReceiverConfig
¥UBX_F9_100_HPG_112_7ZED_F9P.a26bfd58dfd11c233f8fdbabba9adcsa.bin”

C:¥Program Files (x86)%¥u-blox¥u-center_v20.01¥ubxfwupdate.exe -p STDIO -b 9600:9600:9600 —no-f

LIERR
Lo6

Product Change Note
133K8
n/software desig
105 KB
oduction Depleyment
Conformity Declaration
216 KB
C tification
Firmware Update
1.02MB & L
n/software design Deployment
verview
F 351MB
Deplaym
356 KB
548 KB
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https://www.u-blox.com/en/product/zed-f9p-module#tab-documentation-resources

2. F9P setting

7. Download configuration sample file for FOC.

http://www.denshi.e.kaiyodai.ac.jp/gnss tutor/pdf/F9C/FOC 5Hz NMEA.txt

Load configuration file from Tools>Receiver Configuration.

After loading configuration, don't forget to do “save config” before power off the receiver.

® comi3 - u-center 20.01
File Edit View Player
OE &~

Receiver Tools Window Help

Firmware Update...

Legacy Firmware Update...
Dump Receiver Diagnostics...
u-blox 7/8/M8 Retrieve Log...
AssistNow Offline

AssistNow Online

Ctrl+U

Receiver Configuration...

D Messages - usx -
- LOG (Data Log

Hotkeys...
Preferences...

Load/Save Receiver Configuration

Generation:

u-blox Generation 3

Configuration file;

|E:'\Document\GNSS\LIIJIDH\LIIJIDH_FSF"\H eceiverConfighFaC_5H z_j

@ comMi3 - u-center 20.01

" MGA (Multiple oryss
E- MON (Monitor)
|~ BATCH (Data Batc

Partz)

mermdlocE rar Mo

Edi..

Save configuration
Rietries (for every meszage]): E

Load configuration

-

Transfer GMSS -» File

Transfer fle - GHSS |

Cloze
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File Edit View Player Receiver Tools Window Help

O E ~ Connection I EO EE - EH-E
. Baudrate > |
- v v | dE A )  eE—
” MTRIP Server/Caster..
D : MU NTRIP Client...
B LOG (Data Logq 4 T T
-- MGA (Multiple
. t Debug Messages arch
= MOM (Monitor) ) . s
- BATCH (Dat3 Generation
Protocol Filter >k
- COMMS (Cq OUT-LEX NAW ODO UART2 - U1
- EXCEPT (Exc Action ¥ Hotstart 3
 GNSS (Defa Differential GNSS Interface... Warmstart 0
- HW (Hardwg 1
' : Coldstart
. HW2 (Extend Epoch detection... 1
s e e
- HW3 (Exteng B GFG-MS Save Config 1
10y Swet - GFG-MS 2 L 1
IO (IO Syster . CFG-MS =) .
- MSGPP (Me - GFG-MS Revert Config :
- PATCH (Instd - CFG-MS u
5 ' TS 9 M- CFG-MS ¥ Auto Detect
- RF (RF Inforr E- CFG-MS Gat Inf i
. RXBUF (RX B - GFG-MS Et ‘mormation u


http://www.denshi.e.kaiyodai.ac.jp/gnss_tutor/pdf/F9C/F9C_5Hz_NMEA.txt

. FOP setting

‘NMEA...GGA, RMC, VTG...5Hz
If you want other sentences, please customize yourself.

Example : output UBX-NAV-

PVT

7. Note: This sample configuration file output following sentence to USB memory and ESP32.

2. Change value and “Set in RAM"

Value 1= output enable
Value O=output disable

4 u-blox 9 Advanced Config View E
GNSS Configuration Sort Search Selected Configuration Ttem @
Advanced Configurationlj r ‘ Key Mame (ID): |CFGMSEDUT—UBXﬁNAVJVTﬁUARTl (0x20910007)

@ cOM13 - u-center 20.01
File Edit View Player Receiver Tools Window Help
OEE Packet Console F&
Binary Console F7
- v U |
Text Console | S—
Messages View F9
P T ani FO
I Generation 9 Configuration View I
Statistic View F10 DMIT
Table View F11
Becont Tahla Ve

- GRG-MSGOUT-UBH_NAY ODO_UIART2
- GFG-MSGOUT-UBX_NAY ODO_LISE
- GFG-MSGOUT-UBK_NAV ORE G
i G FG-MSGOUT-UBH_NAW ORE_SFI
- GFG-MSGOUT-UBK_NAW ORE_UART
- GFG-MSGOUT-UBH NAY ORE_IART2
- GFG-MSGOUT-UBX_NAY ORE_UISE
- GFG-MSGOUT-UBX_NAY_POSECEF I2G 1 U1 0 0x0

[ SUTD (el
[

[

c

c

o

[

i | .

- GFG-MSGOUT-UBR_NAY_POSECEF_SFT: U1 0 0x0
e

[

[

i

c

e

[

[

UTD
U1 D 0x0
U ox0
Ut n oxo
SUTD (el
UTD Dl

- GFG-MSGOUT-UBX_NAY_POSECEF_UARTT: U1 0 0x0
#- GFG-MEGOUT-UBX_NAY_POSECEF_UART2: U1 0 Dx0
#l- GFG-MSGOUT-UBX_NAY_POSECEF_USB: U1 0 D=0

il- GFG-MEGOUT-UBX_NAY_POSLLHI2G - U1 0 00

- GFG-MSGOUT-UBX_NAY_POSLLHSPT - U1 D ix0

- GFG-MSGOUT-UBX_MAY_POSLLH UARTT - U1 0 0x0
#l- GFG-MSGOUT-UBX_NAY_POSLLH UART2 : U1 0 Oxd
#l- GFG-MSGOUT-UBX_NAV_POSLLH USE : U1 0 Ox0

1 GFG-MSGOUT-UBX NAY PWT 120 U110 020

- GFG-MSGOUT-UBK NAV PVT USE < U1 D 0x0
£ CFG-MEGOUT-UBH_NAV_RELPOSNEDI2C - U1 0 0x0
i CFG-MSGOUT-UBH_NAW RELPOSNED SFL U1 0 00
- GRG-MSGOUT-UBH NAY RELPOSNED_UART! : UT 0 0x0
- GFG-MSGOUT-UBX_NAY RELPOSNED_UART2 : UT 0 0x0
- GFG-MSGOUT-UBX_NAY RELPOSMED_USE : U1 0 0x0

- CRG-MSGOUT-UBK NAVSATIO -~ UID 0x0
- CFG-MSGOUT-UBK NAVSATSFL U1 D 0x0
- GRG-MSGOUT-UBK NAVSAT UARTY U1 1 Ox1
- GFG-MSGOUT-UBX_NAV SAT UART2 U1 0 0x0
- GFG-MSGOUT-UBK NAVSAT USE < U1 D 0x0
B CFE-MEGOUT-UBK NAVSEAS G - U1 -
- CFG-MSGOUT-UBK NAVSEAS SPL - U1 -
- GFG-MSGOUT-UBK NAV SBAS UARTY © UT -
- GFG-MSGOUT-UBK_NAV SBAS UART2 © U1 -
5 CFG-MSGOUT-UBK_NAV.SBAS USE - UT -
- CFG-MSGOUT-UBK NAVEIRIG - U1 0 0xd

¥ U0 i
- GFG-MSGOUT-UBX NAVSIG UARTT < U110 k0
- GFG-MSGOUT-UBX_NAV SIG UART2 < U110 B0
- CFG-MSGOUT-UBX_NAVSIGUSE U1 D 0x0
5 CFE-MSGOUT-UBK NAVSLAS G - U1 -
- CFGE-MSGOUT-UBK NAVSLASSPL - U1 -

3l OFG*MSGOUT*UEXﬁNRVﬁSLRSiLIARTW U1 -
i- GFG-MSGOUT-UBX_NAV SLAS_UART2 : U1 -

- CFO-MEGOUT-UBK_NAV SLAS USE - U1 -
B CRE-MSGOUT-UBK NAVSOLIG Ul -
B CRE-MSGOUT-UBK NAVSOLSFL Ul -
3 GFG-MSGOUT-UBX_NAY SOL_UARTT U1 -
- GFG-MSGOUT-UBK_NAY SOL UARTZ U1 -
- CFG-MEGOUT-UBK_ NAV.SOLUSE U1 -

- GFG-MSGOUT-UBK NAVSTATUSI2G U1 0 0xD
7. CFG-MSGOUT-UBX NAY STATUS SPT - U1 0 Dx0
b GRG-MSGOUT-UBX NAV STATUS UARTT: U1 0 (0

[
[E
c
I
[
[
c
c
o
[
[
c
c
o
[
i
c
- GFG-MSGOUT-UBR_NAY _SIG_SFT
[
[
i
c
e
[
[
[E
c
[
[
[
2
c
I
[

Qutput rate of the UBX-NAV-PVT message on port UARTL

Value: [1 I

Value (hex): |1

I Set in RAM I Setin BBR

Set in Flash ‘

List of configuration changes (Red duplicates ignored)

Trems to delete

Load differences from default

Key Name (Key ID)

1. Select Message
"xxx_UART 1"

Items to set

I Send config changes I
Layer

3. After queue was set
click "Send config change”

4. Change UART1 “Protocol out”
as suitable as your output
message at message window.

=

Key Name (Key ID)

Clear lists

UBX-CFG-VALSET message hex codes

CFG-MSGOUT-UBX_NAV_PVT_UARTL (O...

Value
1 0xd

Layer
RAM ...

Load from file... | Save to file...

D messages - URX - CFG (Config) - PRT (Ports)

Ram fayer config message:
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b5 62 06 82 09 00 00 01 00 00 07 00 91 20 01 53 48

<
& xI Send I;!pnu

Ed

* | UBK-CFG (Confisl- PAT Ports]

Taiget

Fuoloed n g

ot ot

UBX-NMER

A B

Boudme 115200
L |
Sopbis |1 =l
Paily [Nore: -
BiOder (5B Pt -

I Eserded T tamecud [>=FW7.00)
T Aleady Feahue [=FWT,00]

I~ Ensble

T

Thieshold
FiD o =l

>

@ < 5 M




3. Data logging

USB memory data logging will automatically start when you power on FOC.

And disconnect power USB, it stop logging.

Power bank (5V) £

Power supply frogaliiis USB port
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3. Data logging

You can salvage data from USB memory. (USB memory data format should be FAT32)

% - 1\ » USB-FL [G:I 3 ﬂl G:¥LOGO113.TXT - EmEditor - O X
- WD EEE BRSO W Y-bD HVEIW  ALTE)
o _ _ _ D-2-HI&B xBH O~ -¥~-|LoPP|E |§@E|d'JJE'| U=l
*:‘f;jjf_‘\ X “iE"i“a_'r'l“i“__""E E ECE'—."EI’CDH'Q x USB-FL{G'} X I T T T R T T T R - Y ... 198, .1 A
. 2071| $GNRMC, 014303 .00, A, 3540. 3349378, N, 13948 . 7968841, E, 6.024, , 200420, , ,F,V*1D)
\I' -1 B;j ‘ A ‘ El- & ﬁf ¥ 2072 $GMVT6, T, M, 0.024, N, 0.044, K, D*3EL
S - 2073 | $GNGGA, 814303 .00, 3540. 3549378, N, 13948. 7968841, E,5,12,0.64,22.032,M,39.475,M, 1.0, 0006*59.
BF A~ 0O &# =l
E 2074| $GNRMC, 81438320, A, 3546. 3349398, N, 13948 . 7968862, E, 8.036, , 200420, , ,F,V*13)
BT A-LOEHT : : — 2075| $GNVTG, ,T, M, 8.036,N,8.066, K, D*30)
s kaiyodai 2020/02/14 11:17 2076| $GNGGA, 81430320, 35483349398, N, 139487968862, E,5,12,0.64,22.026,M,39.475, M, 1.2, 8000*53)
= A LOGOO00.TXT 2020,/03/30 8:08 2077 | $GNRMC, 0143083.40, A, 354@.3349379, N, 13948 . 7968845 ,E,0.819, 200420, , ,F,V*12)
I pC - - 3'_3 ] 2078 $GNVTG, , T, ,M,0.019,N,0.035, K, D*36.
< LOGOOO.TXT 2020/03/30 8:12 2079| $6NGGA, 014303.40,3540.3349379, N, 13948. 7968845 ,E,5,12,0.64,22.027,M,39.475,M, 1.4, 0000*58
N EDFwbivls A LOGO002.TXT 2020/03/30 816 2080| $GNRMC, 014303.60, A, 3540. 3349440, N,13948. 7968840, E, 0.017, , 200420, , ,F,V*16/
. P 2081| $GNVTG, , T, ,M,0.817,N,0.0832,K,D*3F )
00— o LOGR03.TXET 2020003730 8:20 e T o
¥ 7v0-F 4 feee 2082 $GNGGA, 014383 .60, 3540. 3549448, N, 13948. 7968848, E,5,12,0.64,22.821,M,39.475,M,0.6,0008*57,
W FATT A LOGOO04.TXT 2020/03/30 8:29 2083| $GNRMC, 014303.80, A, 3540. 3349467 N, 13948. 7968833, E, 0.031, 200420, , ,F,V*1D/
- 2085 $GNGGA, 814383 .80, 3540. 3549467, N, 13948. 7968833, E,5,12,0.64,22.024,M,39.475,M, 0.5, 0006*53
= F7Fw 4 LOGD006.TXT 2020/03/30 8:36 2086/ $GNRMC, 814384 .00, A, 3540. 3349466, N, 13948 . 7968835, E, 0.15, , 200420, , ,F,V*13!
B v 4 LOGODO7.TXT 2020/03/30 8:38 2087| $6NVTG, , T, ,M,0.015,N,8.628, K,D*36)
) B oG %T S 030/03/30 86 2088 | $GNGGA, 81430400, 3540. 3549466, N, 13948. 7968835, E,5,12,0.64,22.021,M,39.475,M, 1.0, 0006*57
T ’ 0008. SreREE e 2089 $GNRMC, 014384.20, A, 3540.3349481,N, 13948 . 7968825, E, 8.035, 200420, , ,F,V*1B v
i OO 71R7 4 LOGO009.TXT 2020/03/30 847 188 KB (192512 /1), 2,939 7. Text 143,14 BFE (Y7 s) 0XF 02939 17
1 4 ommmma i T . i -
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4. Bluetooth setting

You can get RTK position with your smartphone (Android).

1. Install Arduino IDE in your PC.
https://www.arduino.cc/en/main/software

2. Download sketch for ESP32.

Case2 Ntrip
(" Antenna |
Bluetooth
/ RTK Result ]
4 Fac )
ESP32
! USB

ZED-FOP Memory Power

N RTK 7| data ) bank

RTK Result

http://www.denshi.e.kaiyodai.ac.jp/gnss tutor/pdf/FOC/ESP32 BT FIC v2.zip

TUMSAT GNSS Lab
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https://www.arduino.cc/en/main/software
http://www.denshi.e.kaiyodai.ac.jp/gnss_tutor/pdf/F9C/ESP32_BT_F9C_v2.zip

4. Bluetooth setting

3. Open downloaded sketch “ESP32_BT_F9C_v2.ino"

4. Install the library for ESP32.
Tool>Board>Board Manager. Then search by “esp32” and install the library.

9 £SP32_BT_FaC_v2 | Arduino 1.8.12
Irfll BE AT9F Y- AT
BEER
ATYFET-N1T3D
ESP2BTFICY  my3-suresE

//This example d S{FSUEEE..
;;By Evandro Cop SUTNE=S

//This example g JUPNIOYS

ffand also demon

WiFi101/ WiFiNINA Firmware Updater

7hi—F: "ESP32 Dev Madule

Upload Speed: "921600"

CPU Frequency: "240MHz (WiFi/BT)"

Flash Frequency: "80MHz"

Flash Mode: "QIO"

Flash Size: "aMB (32Mb)"

Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)"
Core Debug Level: "#&L"

if !defined(CON PSRAM: "Disabled"

Bluetooth HUTFNA-F

h-FERENRE

2
#
2
#
2
#

BluetoothSerial S "AVRISP mkll"
HardwareSerial u .
J-hO-YEEEAG

ins packTimeout 5
PACKET_SIZE 2048
bufl [FACKET_SIZE]:
£ il=0;7

buf2 [PACKET_SIZE]:
int i2=0;

int RTCM length=0;

int bt_len=0;

Cirl+T

Ctrl+Shift+L

H-FeF—t...

pil
Arduino AVRITi—F
Arduino Yin
Arduino Une
Arduino Duemilanove or Diecimila
Arduino Nano
Arduino Mega or Mega 2560
Arduinc Mega ADK
Arduinc Leonardo
Arduino Leonardo ETH
Arduine Micro
Arduinc Esplora
Arduino Mini
Arduino Ethernet
Arduino Fio
Arduino BT
LilyPad Arduino USB
LilyPad Arduino
Arduino Pro or Proe Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor

Arduinc Gemma

{7} | &T w | espdd

espd?

by Espressif Systems /i— %/ 37/1.0.4 INSTALLED

PR ] b= o I =T Rl o

ESPZZ Dew Module, WEMOS LoLin22, WEMOS D1 MINI ESPZZ.
More Info

Bl

13




4. Bluetooth setting

€9 ESP32_BT_F9C_v2 | Arduino 1.8.12

5. Connect F9C with PC by USB cable. 7761w 327 50

BEER Ctrl+T
ATy FET-N1743
IYI-TAYJEEE

ESP32_BT_FAC_y

f/This example d S{TSVEEE.. Ctrl+Shift+|
::::EY Evendse CoH - yupEcy Ctrl+Shift+M
//This example g JUFNIOyE Ctrl+Shift+L

//and alsc demon

WiFi101 / WiFiNINA Firmware Updater

$include "Bluet o
Trme et I mi—F: "ESP32 Dev Module” I >
Upload Speed: "921600" >
#include "Arduin CPU Frequency: "240MHz (WiFi/BT)" >
Flash Frequency: "80MHz" H

CONFIG_FREER o

define ARDUING | Flash Mode: "QICY ¥
Flash Size: "4MB (32Mb)" 4
= RRDUINO_| Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)" >
Core Debug Level: "%L" *
if 'defined (CON it v ]

Bluetooth 7 )Lf—b: "COM15" 5
m-FigdsemE

BluetoothSerial SALEE: "AVRISP mkll" 5

6. Select board type as "ESP32 Dev Module”
and COM port. R o emtas

PACKET_SIZE 2043
byte bufl [PACKET_SIZE]:
int il=0;

byte buf2 [PACEKET_SIZIE]:
int i2=0;

int RICM length=0;

int bt_len=0;

int bufsize=0;

void setup() {

14

SS Lab




4. Bluetooth setting

€9 ESP32_BT_FaC_v2| Arduino 1.8.12 - | X

Change Bluetooth device name as you like. 77 &S 2727 7o N7

Write sketch to the board. e

HardwareSerial uart(2); // ULRT2H{¥3->Fop ~

After writing completed you can disconnect USB i e L
from PC. e e o

void setup() {
Serial.begin(115200);
Pert oo ]loo0nd .

I SerialBT.begin{"F9C_Nol™); //Bluetcoth device name
T o raIr it with bluetooth!™);

xTaskCreatePinnedToCore (loop2, "loop2™, 8152, NULL, 1, NULL, ARDUINO ERUNNING_CORE) ;

void loop2 (volid *pvParameters) |
while (1) {

if (uart.awvailakl={)) {

buf2[i2] = uvart.r=ad():; // read char from UART

if (i2<PACKET_SIZE-1) {

i2++;

1

lelae]
rialBT.write (buf2,i2);

i2=0;

1 W

TUMSAT GNSS Lab



4. Bluetooth setting

9. Power supply to FOC.
10. Pairing F9C with your smartphone.

v'd 1123
& Bluetooth
ON @

fDiERICIE TusRi0750) & LTRRENET

R7BRELLETNAR

FIC_No1 |

AGBGMR-BT-7E36 |

Power bank (5V) f

DELLNI3 |
HC-06 |
Hi9Pro |

LNVT495 |

D 0O ¢ % [p *¢|D
8 & o o & ol

MDR-EX31BN |

FLOWTFNAZERTRETS

O @) d

TUMSAT GNSS Lab
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4. Bluetooth setting

11. Install "Lefebure NTRIP Client” from Google play store on your Android.
Set receiver as F9C and configure NTRIP base station, Then click “Connect”.
You can use RTK position on your smartphone app if you enable “GPS Mock Locations”.

v vl (s 11:23 v'd
m NTRIP Client Receiver Settings NTRIP Settings
i Receiver Connection Network Protocol
. External via Bluetooth NTRIP v1.0
Disconnect .
Bluetooth Device Caster IP . .
35.67229534981326198 P e The mount point should broadcast minimal
RTCM3 messages.
Bluetooth Connection Method Caster Port i
W ——— Bluetc ces Unnecessary messa'ges'wﬂl cause a stack of
11:23:57 GPS Mock Location Disabled Bluetooth communication.
11:23:57 Device: FOC_No1
11:23:57 Trying to Connect... Auto-Enable Bluetooth 0 WL
11:23:59 Bluetooth Device Connected Automatically switch bluetooth on/off | Example .
11:23:59 Fix type is now GPS ’
11:23:59 Using 12 satelllteg Auto-Configure Receiver Password RICM 1006 { 24): staid= 0 pos=35.55193529 139.64700590 94.419 anth=0.000
11:24:01 Network: Connecting... No Auto-Config E— RTCM 1230 ( 15):
11:24:01 NTRIP: Connected to caster RTCM 1074 { 193): staid= 0 2020/04/20 02:43:47.00 nsat= 9 nsig= 4 iod= 0 ncell=24 sync=1
11:24:02 ix type is now DGPS . R e R U ol B o it
e . . ; ata Stream oM 108 83) : = 0 2020/04/20 02:43:47.00 = - — ¢ - 8 sync=
11:24:02 Fix type Is now F!OatRTK Qntggna HEIght K0J27 RTCM 1114 { &6): staid= 0 2020/04/20 02:43:47.00 nsat= 2 nsig= 3 iod= 0 ncell= & sync=1
11:26:26 GPS Mock Location Disabled QN =R RTCM 1124 ( 137): staid= 0 2020/04/20 02:43:47.00 nsat= 9 nsig= 2 iod= 0 ncell=15 sync=0
11:27:21 Fix type is now RTK
Save GPS Data to File O Reported Location
Get from External Receiver
Save NTRIP Data to File (]
E Saved Profiles

GPS Mock Locations
Allow external GPS data to be used by other

TUMSAT GNSS Lab 17




FOC logger can get RTK position and store it in wifi coverage.

The other device in the same LAN can monitor F9C status.

With mobile router

OR

. T -
r o

RTK in Wifi coverage f

TUMSAT GNSS Lab

Case3

ield

Ntrip
| Antenna | |¢.~|
wifi S, ‘\~‘\\
4 F9C )
ESP32 RTK Result
! USB
ZED-Fop || Memory Power
RTK data \ | | bank
\ RTK Result |
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Install Arduino IDE in your
https://www.arduino.cc/en/main/software

PC.

Download the sketch for ESP32 and open the sketch “ESP32_WifiUDP_Ntrip.ino” .

http://www.denshi.e.kaiyodai.acjp/gnss tutor/pdf/F9C/ESP32 WifiUDP_Ntrip.zip

Install the library for ESP32.
Tool>Board>Board Manager. Then search by “esp32” and install the library.

9 ESP32_BT_FeC vz | Arduine 1.812
Tl BE R79F Y-l AT
SRR
AT9FEP-N{T33
ESPIZBIFSCL mya-wroslE
//This example o FTISVEEE..
(/B Brandze CoF - syp)zmy
//This example g 2UFNTOYE

//and alsc demon

WiFi101 / WiFiININA Firmware Updater

#include

= "ESP32 Dev Module"

#includs
#includs Upload Speed: "921600"
#include CPU Frequency: "240MHz (WiFi/BT)"

Flash Frequency: "80MHz"
Flash Mode: Q0"

Flash Size: "4MEB (32Mb)*

Parfition Scheme: *Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)"
Bl

-

Core Debug Level:
PSRAM: "Disabled”
Bluetooth P

T-FMEREDE

-

BluetoothSerial
HardwareSerial u

FHAEE: "AVRISP mkll"
J-bO-FESEAD
ackTimeout 5

ACKET_SIZE 2048

bufl [PACKET_SIZE];

i1=0;

buf2[PACKET_SIZE];

12=0;

int RTCM_length=0;

int bt_len=0:

Cirl+T

Ctrl+Shift+l
Ctrl+Shift+M
Crl+Shift+L

- FYF= ...

Arduin
Arduino Yin

{  Arduino Uno
Arduino Duemilanove or Diecimila
Arduino Nano
Arduino Mega or Mega 2560
Arduino Mega ADK

. Arduino Leenardo
Arduino Leonardo ETH
Arduino Micro
Arduino Esplora
Arduino Mini
Arduino Ethernet
Arduino Fio
Arduino BT
LilyPad Arduino USB
LilyPad Arduino
Arduino Pro or Pro Mini
Arduino NG or older
Arduino Rebot Control
Arduino Robot Motor

Arduino Gemma

Adafeus a0 a

@ -Fyx-v

A47 | 2T | |esp3d]

esp3?

by Espressif Systems /{— %/ 37°/1.0.4 INSTALLED

oy r—YITEZhTLEE-F -

ESP22 Dev Module, WEMOS Lolin32, WEMOS D1 MINI ESP32.
More Info

BALE

TUMSAT GNSS Lab



https://www.arduino.cc/en/main/software
http://www.denshi.e.kaiyodai.ac.jp/gnss_tutor/pdf/F9C/ESP32_WifiUDP_Ntrip.zip

4. Install the library “Ntrip-clilent-for-Arduino-master.zip” from zip file. (In the download folder)

&9 ESP32_WifiUDP_Ntrip | Arduino 1.8.12 B (VAM-NFFSATSURECTPTIPA VST EEELTGE . X
Irdll BE A7yF | v-Il MILT Tr ILDIHFR(D: ESP32 WifiUDP_Mirip v P E
WAL TV Ctrl+R o B} NTRIP-client-for-Arduino-master.zip)
o 2 =y
HIM-FcEEAs  CulsU =
i IR
FAEEEFEI(FEAL G+ Shift+U BiR{%E-£1R
IR TURET] Ctri+Alt+S Val
char® hos Fa 4k
int httpP AruFNIANTEET Ctrl+K t of NTRIF caster B
har G EES
el SegsuEyf a &
char* use ] =451 : P
R TP VAT, ZATFVREE.. Crl+Shift+| T,
NIRIEClient ntrip e: ZPEREDFATNES VAR, ]
WiFiUDP wifiUdp; PG
static const int target_port = 60000; //iF{E5D Arduing 547351
static const int my port = €0000; /BBt — Bridge @ AN MTRIP-client—for-frduino-master z ip 514
IPaddress ipr Esplors FabO-h TrAMDRAHD: [ZPorAnErE o o A
IPAddress target_ip;
Ethernet
HardwareSerial uart(2);//FSF ULZRTL Firmata
byte bufl[PACKET SIZE]: €L
int il=0; Keyboard
byte bufl [PACKET_SIZE]: LiquidCrystal
int i2=0;
Mouse
int cnt=0; Rebot Control
int uart_len=0; Robot IR Remote
int tcp_flag=0; Robot Motor
SD
wvoid setup() { Servo
// put your setup code here, to run once: SpacebrewYun
Serial.beqin (115200} 7
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€9 ESP32_BT_F9C_v2 | Arduino 1.8.12

5. Connect F9C with PC by USB cable. 7761w 327 50

Select board type as "ESP32 Dev Module”

f/This example d

and COM port. /13 Ernien

//This example d
//and alsc demon

BEERE
AryFET-h1793
IVI-FATRETE
S{TSVEER...
SUTNEZS
YUFNTOYS

WiFi101 / WiFiNINA Firmware Updater

#include "Bluetg I

fi—F: "ESP32 Dev Module”

#include "Arduin

= ARDUINO |

if !defined{CON
Bluetooth

Upload Speed: "921600"

CPU Frequency: "240MHz (WiFi/BT)"
Flash Frequency: "80MHz"

Flash Mode: "QIO"

Flash Size: "4MB (32Mb)"
Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)"

Core Debug Level: "%L"

SUTNf—F: "COM15"

BluetoothSerial
HardwareSerial u

m-FERERE

FHAEE: "AVRISP mkil"

J-+O-FESERD

= packTimeout 35
PACKET_SIZE 2043

byte bufl [PACKET SIZE];

int il1=0;

byte buf2[PACKET SIZE];

int i2=0;

int RICM length=0;
int bt_len=0;

int bufsize=07

void setup() {

SS Lab

Ctrl+T

Cirl+Shift+l
Ctrl+Shift+M
Ctrl+Shift+L
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€9 ESP32_ WifiUDP_Ntrip | Arduino 1.8.12 — O *

6. Change following line in the sketch. 5701 88 33 5 7
« WiFi SSID (2.4GHz) PR

#include <NTRIPClient.h> ~
#include <WiFi.h>
o g #include <WiFiUDP.h>
® WI FI pa SSWO rd #include “freertos/FreeRTOS.h"
#include “freertos/task.h"|
#include “Arduinc.h”

o Nt”p Server |P address #if CONFIG_FREERTOS_UNICORE

#define ARDUINO_RUNNING_CORE @
#else
#define ARDUINO_RUNNING_CORE 1

* Ntrip Mount Point

#define packTimeout 5
#define PACKET_SIZE 4896

const char* ssid
const char* password

TEEEEEN . S0 AGHz Wifi S5ID

* Ntrip User name and password —
(Set blank it when you use Mount Point which don't require Crac host - "153.121,50.53% e server 00000

int httpPort = 2181; //port 2181 is default port of NTRIP caster
char* mntpnt = "***";//Mount Point Name

user name and password)
char* passwd = "*****"://Password

NTRIPClient ntrip_c;

WiFiUDP wifiUdp;

static const int target_port = 6@@ee; //E{EFEDF—

static const int my_port = ceess; //BHTILF— |

IPAddress ip;

IPAddress target_ip;

HardwareSerial uart(2);//F9P UARTL

byte bufl[PACKET_SIZE];
int i1=0;

TNTRIP-client-for-Arduino-master) ELV3 34 73 VIZT TIZHEELES. IS—#otE—U%0E-9%

COM1SMm w Madule
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7. Write the sketch to F9C.

You can found the IP address of F9C on

Arduino IDE serial monitor after writing the

sketch.

When FIC is power supplied in the WiFi
coverage, it automatically start RTK and store

its result.

}

}

@ ESP32_WifiUDP_Ntrip | Arduine 1.8.12
JrAl BE ATeF U=l ALT

ESP32_WifiLUDP_Mtrip

if(!ntrip_c.reqgRaw(host,httpPort,mntpnt,user,passwd)){

delay(15008);
ESP.restart();

& comis

25:
25:
25:
25:
:25:
125:
25:
:25:

25.
25.
35.6
35.6
45.
45.
55.
55.

¥
serial.println("Requesting MountPoint is OK");
wifildp.begin(my_port);
xTaskCreatePinnedToCore(loop2, "loop2”,
13:
13:
13:
13:
void loop2(void *pvParameters){ 13
while(1){ 13
if(ntrip_c.available()) { 13
char ch = ntrip_c.read(); 13
uart.write(ch);
}else{
delay(2);
¥
¥

->» myIPRddress = 152.168.100.10 port=60000
-» targetIP=1%2.1653.100.255 port=60000
-» myIPhddress = 192.162.100.10 port=60000
-> targetIP=192.165.100.255 port=60000
-» myIPAddress = 192.1628.100.10 port=60000
->» targetIP=1%2.165.100.255 port=60000

0 -» myIPRddress = 15%2.165.100.10 port=60000
0 -> targetIP=192.162.100.255 port=60000

B#hAon-) e LA TRET

void leop() {//data send by UDP

uvart_len=uart.available();
for({i2=@;i2<uart_len;i2++)q{

buf2[i2] = uart.read(); // read char from UART

wifildp.beginPacket(target_ip,target_port);

wifildp.write(buf2,uart_len);
wifildp.endPacket();
delay(l@);

cnt=cnt+l;

AT GNSS Lab
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8. If you want to monitor RTK result, listen UDP 60000 port in the same LAN as FOC.
Here, we show the example using RTKLIB and u-center on PC.
(F9C will broadcast data to xxx.xxx.xxx.255 of your LAN. Some firewall setting to allow UDP
broadcasting may be required on your WiFi router or PC)

o tcp://127.0.0.1:10001 - u-center 20.01 - [m} bt

File E View Player Receiver Tools Window Help

o gt eae VY ELCERLE B BT
| e R

- ~ _ _ Port
— B 60000
Stream Type Opt Crnd Conv Bytes Bps
(0) Input | UDP Server  [] 656,611 0
(1) Qutput | TCP Server 717,646 0
(2 t v 0 0
) Cancel
3) Output ~ v )
) D packet console
7 R -> NMEA GNVTG, Size 35,
TCP Sewer Optlons X R -> NMEA GNGGA, Size 89,
R -> NMEA GNRMC Size 74,
- R -> NMEA GNVTG, Size 35,
[m} Port R -> NMEA GNGGA, Size 89,
R -> NMEA GNRMC, Size 74,
10001 R -> NMEA GNVTG, Size 35,
: . R -> NMEA GNGGA, Size 89,
W Start 4+ Options... Exit R -> NMEA GNRMC, Size 74,
R -> NMEA GNVTG, Size 35, ourse OQver Ground and Ground Speed’
R -> NMEA GNGGA, Size 89, obal Positioning System Fix Data'
R -> NMEA GNRMC, Size 74 ecommended Minimum Specific GNSS Da
R -> NMEA GNVTG, Size 35, 'Course Over Ground and Ground Speed’
R -> NMEA GNGGA, Size 89, 'Global Positioning System Fix Data'
R -> NMEA GNRMC, Size 74, 'Recommended Minimum Specific GNSS Da
R -> NMEA GNVTG, Size 35, 'Course Over Ground and Ground Speed’
R -> NMEA GNGGA, Size 89, 'Global Positioning System Fix Data'
R -> NMEA GNRMC, Size 74, 'Recommended Minimum Specific GNSS Da v
SRS A [
0K &
Ready Aae NTRIP client: Not connected u-blox Generation ¢ =®= tcp://127.0.0.1 |No file open NMEA |00:27:5!(04:55:0 | &
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6. Erase the sketch of ESP32

How to put back FOC to not use WiFi or Bluetooth
Connect F9C to PC by USB cable and open Arduino IDE.

1.

2. Create new sketch from File>New File.

3.

Write the null sketch to ESP32.

& sketch_apr21a | Arduino 1.8.12
7 e AT 9F Y- AT

sketch_apr2ia

void setup() [

1

- void loop()

1

// put your main code here,

9 ESP32_BT FoC_vz | Arduing 1.8.12
Jrdll &= AToF -l MT
= 7 e Cerl+N
B<... Cirl+0
BiiE-IEEERL 4
]’J")'?j‘)")" yiblic Domain (or CCO licensed, at your option.)
ATyFel ’
FL3 Carl+W between Serial and Classical Bluetooth (SPP)
#E5 Ctrl+S LalBT hawve the same functionalities of a normal Serial
FAMEMITEF  Cirl+ShiftsS
FUSIDEE.. Ctrl+Shift+P
E&l... Ctrl+P
BERSEE Cerl+ 71V
B®T Cerl+Q
_____
#de=fine RRDUINO RUNNING CORE 1
#endif
#if !defined(CONFIG_BT_ENABLED) || !defined{CONFIG_BLUEDROID ENABLED)
#error Bluetooth is not enabled! Please run "make menuconfig® to and enable it
ndi

TUMSAT GNSS Lab

// put your setup code here, TO run onc

to run repeatedly:
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